
Branding Your Website

There are millions of websites out there, yet it is easy to tell as you follow a link when you
have left the website you were on. This is because each site has a distinct look and feel. Occa-
sionally you might run into two (or more sites) that look alike where you can tell that those
sites are using the same theme or template—usually that of a website generator, blog applica-
tion, or a standard template included with a web-editing program such as Expression Web,
Dreamweaver, or FrontPage. In this chapter, you will make your website unique.

You will be working on the look and feel of your website. This is primarily determined by
your choice of colors and images. Each page and section of your site should have the same
look and feel. These are the elements common to every page on your site. The visitors feel at
home when they can tell what to expect from your website. Sites that are radically different
from the norm tend to be ineffective.

In Western culture, that means people expect the top section—or, to borrow a term from
print, the masthead—to identify the site. Site navigation or menus should be clear, easy to
locate, and intuitive to use. The main content section should occupy the majority of the page.
Side columns usually have menus, teasers, related information, and/or advertising. Legal
notices such as copyright, privacy policies, contact information, and so on, are usually in
smaller print at the bottom of the page. These are the sorts of conventions that make your
visitor comfortable. The term mystery-meat navigation was coined to refer to sites that are
difficult to navigate or have menus that are hard for a visitor to recognize as a menu. Your site
menu is an important part of your site’s identity and function.

Although your site may use the same basic layout as thousands of other sites on the Web,
it does not mean that your site has to look the same as every other site on the Internet. Your
choices in color and images will give your site a unique look that will help brand it in the eyes
of your visitors.

Choosing a Color Scheme
When most people start out in web design, one of the most common sticking points is decid-
ing the colors for the website, followed by what images to use. In the case of a business site,
frequently a company logo or official colors will provide a starting point. However, if it is a new
venture or a personal site, you might not have a logo or any other graphics to get you started.

One place to start is to look at the subject matter that will be the content for your website.
In many cases, the content will suggest a particular color. For example, a hobby site about poo-
dles will want to use colors that complement black, silver, apricot, and white—colors that will
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show off the poodles on your site. A site for coastal cottage rentals might suggest sea and sand
colors that people associate with a sunny beach, even if the cottages are not right on the beach.

If you have photographs that relate to the subject of your website, choose the photographs
you like the best, and then pull your color scheme from inside those pictures using the eye-
dropper from the color picker.

If the subject matter of your site doesn’t suggest a color scheme, another method is to take
your favorite color and then use a color wheel to select your colors. There are three basic types
of color schemes: complementary, analogous, and monochromatic colors. Choose one type to
make up the color scheme for your website. Additional resources are available on this book’s
companion website at http://foundationsofexpressionweb.com (including links to more color
resources).

Complementary Color Schemes
A complementary color scheme is one where the colors are taken from opposite sides of the
color wheel. An example of a popular complementary color scheme is blue/orange. The orange
really pops against a dark shade of blue. Use care with complementary color schemes since the
text can appear to vibrate if complementary colors are stacked on top of each other. That is why
you should mix black and white liberally in with complementary color schemes.

A variant called split complementary, or triad, where the color wheel is divided into thirds,
is often used, and colors equal distance apart on the wheel are used. Like a two-color comple-
mentary scheme, a triad scheme will pop but does not tend to cause as much movement to
appear on the screen, which frequently makes it a better choice.

Analogous Color Schemes
Colors that are adjacent to each other on the color wheel make up an analogous color scheme.
These usually go from one primary color to the next or from one secondary color to the next
on the color wheel. A site that uses blue and green as the primary colors would be using an
analogous color scheme.

Monochromatic Color Schemes
Monochromatic color schemes use one color in various shades, which can be very effective
depending on the subject matter of the website. The web page you created in Chapters 6 and 7
uses a monochromatic color scheme.

Choosing Images for Your Site
In its early days, the Web was text only, but it didn’t stay that way for long. Mosaic, one of the
earliest web browsers, introduced the <image> element back in 1993. Although at that time
most websites were text, images soon became the norm on sites.

Like your color scheme, the images you use on your site should relate to your site’s con-
tent and goals. To use images effectively, you will need to edit and optimize them. Always start
with the highest-quality image.

Although Expression Web has some very basic image-editing tools, you should invest in a
graphics editor, especially if you want to create original images or edit photographs. Some of
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these graphics programs will be listed in the resources section on this book’s companion
website at http://foundationsofexpressionweb.com.

Graphics
It is best to use original graphics created just for your site. This prevents several problems:

• Clip art can give your site a cookie-cutter or amateur look when visitors recognize the
graphic from other sites or as included with Microsoft Office.

• Under current law, the person who creates any graphic, text, or code owns the copy-
right even if they have not registered it with the U.S. Copyright Office.

Your graphics do not have to be complex, and simple text effects are frequently one of the
best ways of adding graphics to your site.

Photos
Like with graphics, original images are best:

• Take your pictures with a high-quality digital camera, or scan them from a high-quality
photo print.

• Then optimize them for the Web.

• Few will wait ten or even two minutes for your photo to download.

If you need a higher resolution or larger size for distribution, use a thumbnail with a link
and file size to the larger image.

Stock Photos
Sometimes you don’t have or can’t get the photo you need. This is when you should turn to
stock photos where you can obtain royalty-free images for use on your site. There are photo
disks available for purchase, and many websites sell you a license to use images for as little as
$1 an image. See the resources section on this book’s companion website for a short list.

Image Formats
There are only three image formats you should use on the Web:

• GIF (Graphics Interchange Format): Created by CompuServe and limited to 256 colors,
this format is ideal for line art and images with a limited color palette. It is not good for
complex images with gradients or shading. Until the advent of PNG files, this was the
only format for the Web that supported transparency. Using what is called index trans-
parency, only one color can be transparent in a GIF.

• JPG or JPEG (Joint Photographic Experts): Created primarily for photographs. It works
well for images with gradients or thousands of colors and for complex images.
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• PNG (Portable Network Graphics): Originally created as an alternative to the proprietary
GIF format and offers major improvements. The compression format is lossless. There is
support for both index and alpha transparency. Alpha transparency includes translu-
cence and not just single color transparency. Like JPG files, thousands and even millions
of colors are supported.

All these formats compress images to make the file size smaller and download faster. The
first two types, GIF and JPG, are lossy, which means pixels are thrown out. This can cause the
image to degrade. In GIFs, colors are simplified and may look flat. With JPG, you lose detail as
some of the subtler shading is lost, and if the compression level is too high, artifacts, areas
where an image may appear blocky or blotchy because of image overcompression, may be
visible in the image.

Adding Images to Your Web Pages
The first thing you need to know is that you can count on a web browser to display only those
images that are in GIF, JPG, or PNG format. These are the only three formats that all modern
web browsers support. Older web browsers (Netscape 4 and Internet Explorer 3 and below)
support only GIF and JPG images. As you saw in Chapter 7, PNG support in Internet Explorer 6
and below does not support translucent effects that rely on alpha transparency. These older
browsers support only the more limited single-color index transparency.

Every image on your web page requires four attributes:

• Location of the image: src="images/book.jpg"

• Height of the image: height="239"

• Width of the image: width="181"

• Alternative text: alt="Foundations of Expression Web"

■Note Before you insert an image into a web page in Expression Web, save the web page first to make
sure that the correct path is used.

If you do not supply a height and width on your image, your page will appear to take
longer to display since some browsers will not start displaying the page until after the images
finish downloading. Other browsers will continue to load the page and then shift the content
after the images download. Neither option is good for your visitor.

In Expression Web, you can insert a picture by selecting Insert ➤ Picture ➤ From File (Fig-
ure 8-1), which will automatically insert the height and width of your image.
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Figure 8-1. To browse to your image, use the Insert menu to launch the Picture dialog box.

Then browse to the folder where your image is located to insert it on the page. Alterna-
tively, you can locate the image in your folder list and drag it to the location you want your
image to appear on your web page. Either way, Expression Web will add the image height and
width when the image is inserted in your web page. Whether you select your image by using
the Insert ➤ Picture method or by dragging it from your folder list, you will be promoted by
the Accessibility Properties dialog box to supply alternative text for the image, as shown in 
Figure 8-2.

Figure 8-2. Alternative text is required to validate your web page.

Do not ignore this box by using the Cancel button. If your image conveys meaningful infor-
mation or is anything other than purely decorative, make sure you provide a short description
of what the image is meant to convey. This is particularly important when it comes to images
used as links because visitors will not know where the link goes if there is no alternative text.
Not only is alternative text required for your web page to validate, but if your image fails to
load for any reason, the visitor will be left with a red X and no clue what is missing. Without
this alt text, those using screen readers will know there is an image but will not know what 
the image shows.

If your image is purely decorative, it may not belong in the HTML at all. You should add
decorative images to your page via your stylesheet as a background to a <div> or other element.
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■Tip alt information should be short and descriptive of either the image or its function. Think about what
you would say if you were reading the page to someone over the phone.

In many cases, you will want your image to be on the side of your text and to have your
text flow around the image. The way to align your image to the left or right of other content is
to use float. Unlike print, you cannot flow text to both sides of an image.

■Caution If the image you intend to use is not in your local website, make sure you import the image into
your website before you insert it into your page.

Using floats for aligning images and other elements is a little different from using floats
for laying out web pages as you did in the preceding chapter. Although float basics are the
same, padding and clearing become more important. In Exercise 8-1, you will create a simple
masthead using one small image that could be a logo or a product, before you move on to
using images in your masthead.

Exercise 8-1. Floating an Image

For this exercise, I will be using the cover of this book as the image; you can download this image by going to
http://foundationofexpressionweb.com/exercises/chapter8. You can also use an image of your
choice from your local computer.

1. Import the book image and/or the chapter files into your local exercise website. If you prefer, you can use one
of your own images; choose one that is no larger than 300px wide and 300px high (but it can be smaller). If
you need to resize your image and do not have a graphics editor, you can use the Auto Thumbnail button on
the Pictures toolbar (Figure 8-3) to resize your image or the Crop button to trim it. To launch the Pictures tool-
bar, select View ➤ Toolbars ➤ Picture.

Figure 8-3. The Pictures toolbar provides simple editing capabilities.

2. Begin with a new blank web page, and add an <h1> title and a short unordered list. The code I will be using
is as follows:

<h1>Expression Web<br />
The Basics and Beyond</h1>
<ul>
<li>home</li>
<li>about</li>
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<li>exercises</li>
<li>links</li>
<li>contact</li>

</ul>

3. With your cursor to the left of the word “Expression” in Design view, insert the image into your web page
using Insert ➤ Picture ➤ From File. In Expression Web, you do not see thumbnails of the images for you to
visually choose from in the Picture dialog box, as shown in Figure 8-4.

Figure 8-4. Insert ➤ Picture ➤ From File launches the Picture dialog box.

4. To make it easier to remember what formats browsers recognize, use the Web Image Formats filter with the
Picture dialog box to insert your images, as shown in Figure 8-5.

Figure 8-5. Show only those images that will display in your visitor’s browser using the Web
Image Formats filter.

5. When you insert your image, don’t forget to fill in the alt attribute when you see the prompt, as shown
earlier in Figure 8-2. Expression Web will insert the height and width of your image for you. If your image is
inserted inside an existing structural element, you should see the bottom of the image lining up with the
bottom of the text, as shown in Figure 8-6.
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Figure 8-6. Image in the normal document flow

6. Now create a new class called floatleft, as shown in Figure 8-7. Although some browsers require a width
to properly float an element, do not specify a width in the floatleft class since this class can be used with
a variety of different images or other items where the width is specified in the HTML as you specified on the
CSS tab of Page Editor Options. This allows you to use floatleft as a generic class, which is more efficient.

Figure 8-7. Creating generic float classes keeps your CSS simple.

7. Apply the class you just created to your image, and then preview the page. The result may not be exactly
what you expect, as shown in Figure 8-8.
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Figure 8-8. The floated image may need padding for adjoining elements to display correctly.

8. Make a note of the position of your floated image in relationship to the elements around it. In Figure 8-8, the
image precedes the <h1> element. Move the floated image inside the <h1> element. Does it make a differ-
ence if the image is inside an HTML element such as a header or a paragraph?

9. Create a second class called floatright identical to the first class, but with the float property set to
right instead of left.

10. See what happens as you move the image around in the source code and change float: right; to
float: left;.

11. When you change the location of the image to the right (Figure 8-9), it no longer looks crowded since the
text does not reach all the way to the right of the page, but that might not be where you want the image
placed on the page.

Figure 8-9. When floated to the right, the image no longer crowds the short text next to it.
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12. Add text to your page; see the sidebar called “Placeholder Text” if you do not have a block of text available or
did not download the sample files. Move the floated-right image to a section of your page where the text is
long enough to wrap, and you will see the same crowding effect happen but to a lesser degree, as shown in
Figure 8-10. (If you do not have content ready to put in a page to see how your page will look, see the sidebar.)

Figure 8-10. Text will wrap around the floated image as needed.

13. To allow for whitespace between the text and the image, you need to add padding to the opposite side of the
float. This means adding padding-right: 1em to the floatleft class and padding-left: 1em to
the floatright class, as shown in Figure 8-11.

Figure 8-11. The shaded area (blue when seen in Expression Web’s Design view) represents
the padding applied to the floated image.
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Most websites will have at least a few floated images, and creating a couple of generic classes to float your images
left or right will cut down on the number of classes you need in your stylesheet. Save the file as masthead.html in
preparation for the next exercise.

PLACEHOLDER TEXT

You will often be working on your website design before you have the page content, but it can be difficult
to tell what your page will look like when there is content. Enter placeholder text, which is traditionally
fake Latin text called Lorem Ipsum. This type of text is so common that you can find large blocks of it 
on the Web that you are free to copy without the explicit permission of the site owners at sites such as
http://www.lipsum.com/.

Latin is not the only type of placeholder copy available; try some of these generators for something
different:

• An ever-changing selection of text: http://www.malevole.com/mv/misc/text/

• Firefox/Mozilla browser extension: http://mozmonkey.com/loremipsum/

• Generated from Hitchhiker’s Guide to the Galaxy or the Bible amongst others:
http://johno.jsmf.net/knowhow/ngrams/

• Corporate Speak, Press Release Generator:
http://www.lurkertech.com/chris/corpspeak.html

• Text from public-domain works: http://www.gutenberg.org/wiki/Main_Page

Or you can simply create your own.
If you are redesigning an existing site, you can reuse the current content while waiting for new

content, but in many cases it is better to use something that is clearly not related to the subject of the 
site to make sure that the content gets updated. More information on placeholder text is available at
http://clsc.net/tools/lorem-ipsum.htm.

Establishing Your Look and Feel
As I’ve discussed, there are a limited number of basic layouts, and what sets your site apart is
the colors and images you choose to create your look and feel. It is generally accepted that you
have ten seconds or less to grab your visitor’s attention, or they will leave your page. This does
not mean you have to have the latest-and-greatest gee-whiz factors on your site. But it does
mean that your site visitor needs to be able to tell instantly that your site has what they want.
This means using images that relate to the subject of your site, a color scheme that attracts but
does not distract, or other style elements that will allow your visitor to find what they need on
your site.

When you have selected the primary image for your site, whether it is a logo or other
image, use it in the same location on every page of your site. That location is typically in the
top section of your page, which is frequently called the masthead. Below your masthead you
will have one to three columns of content, which are typically followed by the page footer with
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legal information such as copyright notices, links to your site’s privacy policy, a site map link,
or other useful information.

In establishing your site’s look and feel, begin with the basic page-level defaults. Choose
your font family and default background and text colors. Many people find it easier to read sans
serif fonts on the Web. Since browsers do not always have the same color and spacing defaults,
it is best to set them explicitly. Then you can add padding or margins back in as appropriate
while creating your site’s look and feel. A good basic page definition to begin with is as follows:

body {
font-family: Tahoma, Helvetica, Arial, sans-serif;
color: #000000;
background-color: #FFFFFF;
padding: 0px;
margin: 0px;

}

■Note I will be using this body definition in the exercises for the rest of this chapter.

In most cases, your primary branding will be established by your masthead. Picture 
your favorite website, and the odds are good that what comes into your mind is the mast-
head. Figure 8-12 shows a few popular examples. Exercise 8-2 shows how to create your own
masthead.

Figure 8-12. Examples of mastheads establishing site branding
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Exercise 8-2. Creating a Masthead

In this exercise, you will go through the process of creating the masthead shown in Figure 8-13.

Figure 8-13. Finished masthead

1. Beginning with the book image used in the preceding exercise file, use the floatright class to move the
image to the right, and add the body style from earlier in this chapter. Make sure that the image element is
before your <h1>.

2. Next, wrap the text but not the image in a <div> using the right-click drop-down menu in the Quick Tag bar
to select Wrap Tag, and give the new <div> an id of masthead. In Figure 8-14, I applied a black border so
that you can see happens when a floated image is bigger than the container that you want to hold the image.

Figure 8-14. Images will overflow their container when floated.
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3. To keep images inside the masthead <div>, you need to specify a height or use a clearing element. In this
case, you want to have the masthead line up with the top of the orange section of the image instead of
clearing the image completely. Using a screen ruler gives you a height of 119px. To make the book visually
separate from the masthead, add a 1-pixel line to the left of the image using margins or padding.

4. Next, modify the masthead style to have a black background and text the same color as the orange in the
book with a text-align attribute of right with the following CSS:

#masthead {
background-color: #000000;
padding: 0;
margin: 0 124px 0 0;
color: #FDB928;
height: 119px;
text-align: right;

}

5. The HTML for your masthead has the image preceding the masthead <div> to address differences where
the padding for the <h1> element is calculated from in Firefox, Internet Explorer, Opera, and Safari. To
ensure that each of the browsers is using the same starting location, you have to specify a right margin 
of 124px (two pixels less than the width of the image) in CSS Properties or Modify Style.

■Caution Remember that defaults are not always the same between browsers, but when you explicitly
set the margin and padding, the browsers should render your content as you expect.

<body>
<img alt="Expression Web Book" src="images/book.png" 

width="126" height="164" class="floatright" />
<div id="masthead">
<h1>Expression Web Designer</h1>

</div>
<ul>
<li><a href="javascript:void ()">home</a></li>
<li><a href="javascript:void ()">about</a></li>
<li><a href="javascript:void ()">exercises</a></li>
<li><a href="javascript:void ()">links</a></li>
<li><a href="javascript:void ()">contact</a></li>

</ul>

■Note JavaScript null links were used as placeholders, as explained in Chapter 4.
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6. As you can see in Figure 8-15, the site branding is starting to take shape.

Figure 8-15. With the background and text colors set, you have the beginnings of a masthead
(as shown in Internet Explorer 7).

7. If you were to preview this page in Firefox at this stage, you would see slight differences in how the
masthead appears, primarily because of the default text size differences. In both browsers, adding padding
between the heading 1 and the image is necessary. Since both browsers see the right edge of the masthead
as starting the same number of pixels from the right edge of the browser window, you can now add padding
to your <h1>. You also want “The basics and beyond” to be displayed smaller than the first line of text but to
line up on the right side. Accomplishing these two goals requires two style definitions: one for the <h1> ele-
ment and one to shrink the size of the second line. The CSS is as follows:

#masthead h1 {
padding: .5em 1em;
margin: 0;
font-size: 1.5em;

}
.tagline {
font-size: .75em;

}

8. Select the second text in the second line of the <h1>, and double-click the .tagline class in the Apply
Styles task pane.

9. In Figure 8-16 you can see that you are getting closer to the final site branding but the menu is still display-
ing as a basic unordered list.

Figure 8-16. Your text is now positioned and sized for the masthead.

CHAPTER 8 ■ BRANDING YOUR WEBSITE 221



Creating the Menu
In Chapter 4, I recommended using an unordered list as a menu. In this section, you’ll take
that unordered list and turn it into a horizontal menu. To begin, you will wrap your list in a
<div> with the id of menu with the following style using New Style dialog box:

#menu {
background: url('images/menu-bg.gif') repeat-x bottom #FDB928;
height: 45px;

}
#menu ul {
margin: 0;
padding: 0 1em 0 0;
text-align: right;

}
#menu li {
display: inline;
border-left: 1px solid #000000;

}

The previous code gives your menu the same orange background as is used in the curved
section of the book image. A small slice was also taken out of the bottom of the book to con-
tinue horizontal lines in two shades of gray across the bottom of the menu section. This image
is very small and repeats horizontally along the bottom of the <div> (download the zip file for
Chapter 8 from http://foundationsofexpressionweb.com/exercises/chapter8—the image is
in the images folder). The menu now looks like Figure 8-17.

Figure 8-17. The unordered list of links is now a horizontal menu.

Although your menu is now horizontal thanks to the display: inline; property, it is not
an attractive menu, with the links crowded up against the border used to visually separate the
links and the text high in the orange section. You can use one of two methods to center the
links in the menu bar:
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• Add margin or padding, but that would not scale well if the visitor needs to enlarge the
text size.

• Change the line height to the same as the <div> height. This is the method you will use
since it allows the visitor to increase the text size two sizes while still keeping the text
inside the menu.

Adding padding to the left and right of your links will add the whitespace so badly needed
between the links. Finally, for a simple rollover there is a slightly increased contrast on the text
and an underline only on hover:

#menu a {
display: inline;
border-left: 1px solid #000000;

}
#menu a {
line-height: 40px;
padding: 0 .3em;
text-decoration: none;
color: #333333;

}

With the link spacing and mouseover behavior added, the menu now complements the
website, and you could stop with Figure 8-18.

Figure 8-18. The basic menu is complete.

You could stop here or simply add a 6-pixel left margin to keep the same line as in the
lower part of the book. Instead, taking a small slice out of the bottom right of the book image
and flipping it in your graphics editor, you can add a matching curve to the menu (the image
is called menu-lft.gif).

Adding the left rounded corner using the image as a background would be best since it is
purely presentation, but you already have a repeating background image used to create the
bottom border. As a result, you will add the corner image and float it left inside the menu
<div>. Since this image is purely decorative, the alt attribute should be empty. The final
HTML that makes up your site masthead section is as follows:

<body>
<img alt="Expression Web Book" src="images/book.png" width="126" height="164"

class="floatright" />
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<div id="masthead">
<h1>Expression Web<br />
<span class="tagline">The Basics and Beyond</span></h1>

</div>
<div id="menu">
<img alt="" src="images/menu-lft.gif" width="33" height="45"

class="floatleft" />
<ul>
<li><a href="javascript:void ()">home</a></li>
<li><a href="javascript:void ()">about</a></li>
<li><a href="javascript:void ()">exercises</a></li>
<li><a href="javascript:void ()">links</a></li>
<li><a href="javascript:void ()">contact</a></li>

</ul>
</div>

This makes up your finished masthead with both corners rounded, as shown in Figure 8-19.

Figure 8-19. A finished site-branding masthead for this book

Finishing the Site Links
The next step is to make the links do something. In Chapter 4, you saw how to create a hyper-
link to existing pages. You can use the same method to create new pages for each of the links
to pages that do not yet exist, as shown in Exercise 8-3.

Exercise 8-3. Creating a Hyperlink to a New Page

Begin with either the HTML code used in this chapter or any simple link.

1. Select the <a> element surrounding the about link in the menu shown in Figure 8-20, and select Hyperlink
Properties.

2. In the Edit or Add Hyperlink dialog box, select Create New Document from the left column, and then type the
filename for your new page, as shown in Figure 8-21. If necessary, you can change the location of the file in
your website using the Change button. Use the “Edit the new document later” radio button. In Chapter 9, you
will be applying a dynamic web template to the pages you create using this method.
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Figure 8-20. Launch the Hyperlink Properties dialog box.

Figure 8-21. You can quickly populate your website with blank pages to match your 
site navigation.
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3. For pages that exist, use the Existing File or Web Page option in the “Link to” category, as shown in 
Figure 8-22. You do not need to add new pages at this time since they can be created using a dynamic web
template in Chapter 9.

Figure 8-22. You can use the same method to add existing pages to your site navigation.

The masthead you created in this section is more complex than you may feel comfort-
able creating at this stage because of the precision needed in placing the menu. Most of the
mastheads you will create will be simpler, consisting of an image and text without complex
positioning.

When you see a web page and want to learn how it was created, you can open the page in
Expression Web and explore how it was done. For example, the masthead used on starttoweb.com
consists of an image as the background of the masthead that is sized to prevent the image from
being cut off. The masthead used on by-expression.com uses a repeating background image
sliced from the right edge of the logo to create the illusion of a graphic that expands and con-
tracts with the width of the page.

Before you move on to turning your web page into a template, you need to finish up by
adding the two-column layout shown in Figure 8-19. The code for this page is as follows:

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN"
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd">
<html xmlns="http://www.w3.org/1999/xhtml">
<head>
<meta http-equiv="Content-Language" content="en-us" />
<meta http-equiv="Content-Type" content="text/html; charset=iso-8859-1" />
<title>Chapter 8</title>
<style type="text/css">
body {
font-family: Tahoma, Helvetica, Arial, sans-serif;
color: #000000;
background-color: #FFFFFF;
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padding: 0px;
margin: 0px;

}
.floatleft {
float: left;

}
.floatright {
float: right;

}
#masthead {
background-color: #000000;
padding: 0;
margin: 0 124px 0 0;
color: #FDB928;
height: 119px;
text-align: right;

}
#masthead h1 {
padding: .5em 1em;
margin: 0;
font-size: 1.5em;

}
.tagline {
font-size: .75em;

}
#menu {
background: url('images/menu-bg.gif') repeat-x bottom #FDB928;
height: 45px;

}
#menu ul {
margin: 0;
padding: 0 1em 0 0;
text-align: right;

}
#menu li {
display: inline;
border-left: 1px solid #000000;

}
#menu a {
line-height: 40px;
padding: 0 .3em;
text-decoration: none;
color: #333333;

}
#menu a:hover {
text-decoration: underline;
color: #000000;
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}
#container {
border-right: solid 6px #000000;
border-left: solid 6px #000000;
padding: 0;
margin: 0;
background-color: #000000;
color: #CEDBAE;

}
#leftcol {
background: #000000 url('images/book-corner.jpg') no-repeat;
float: left;
width: 150px;
padding: 100px 4px 10px 10px;
font-size: .88em;

}
#main_content {
padding: .1em 1em;
margin: 0 0 0 165px;
background-color: #F4F5EF;
color: #000000;

}
#footer {
margin: 0px;
padding: .1em 1em;
font-size: .8em;
border-top: solid 1px #666666;
border-right: solid 6px #000000;
border-bottom: solid 6px #000000;
border-left: solid 6px #000000;

}
#footer p {
margin: 0;
padding: 0;
line-height: 1.7em;

}
</style>

</head>
<body>
<div id="container">
<img alt="Expression Web Book" src="images/book.png" width="126" height="164"

class="floatright" />
<div id="masthead">
<h1>Expression Web Designer<br />
<span class="tagline">The Basics and Beyond</span></h1>

</div>
<div id="menu">
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<img alt="" src="images/menu-lft.gif" width="33" height="45"
class="floatleft" />

<ul>
<li><a href="index.html">home</a></li>
<li><a href="about.html">about</a></li>
<li><a href="javascript:void ()">exercises</a></li>
<li><a href="javascript:void ()">links</a></li>
<li><a href="javascript:void ()">contact</a></li>

</ul>
</div>
&nbsp;
<div id="leftcol">
<h3>left side column</h3>
<h3>Branding</h3>

</div>
<div id="main_content">
<h2>main content area</h2>
<p>You don&#39;t need to go as high contrast as this to get your branding
across.</p>
<h2>Overview</h2>
<p>In this exercise we will be creating our website look and feel. Since
there is no content to be placed here yet, placeholder, or what is called
designer text, will be used after this paragraph.</p>
<h2>Created by the Press Release Generator</h2>
<p>Thanks to the recent reorganization, the key players are not going to
step up to the challenge of competitive killer apps. Having first verified
that the drop dead dates give a clear channel towards quality control, a
careful examination of the writeoffs reveals that the scenarios provide
an indication of the established standard application framework.</p>
<h3>Task-oriented disclosures make it happen. </h3>
<p>As always, the workgroups empower compliant turnkey systems? Having first
verified that the goals enable kick-ass graphics, a careful examination
of the best systems in the world reveals that revolutionary RISC technology
is not the object-oriented headcount readjustments. </p>
<h3>More Generated Content</h3>
<p>Now that the merger is complete, content sweetening eventually closes
the loop on the issue of the team players. This is why Tom Jermoluk recently
announced that missions will succeed. The multimedia next generation system
gets your input on price-performance technologies. We&#39;re going forward on
a binary-compatible next generation system. </p>

</div>
</div>
<div id="footer">
<p>© 2007 Cheryl D. Wise</p>

</div>
</body>
</html>
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If you are using your own content, replace the headings, list, and paragraphs inside the
<div> elements with your own content. Save the page as chapter8.html.

■Note In Design view, you may see a gap at the bottom of the page, but you will not see the gap when the
page is displayed in a browser. Although the Expression Web rendering is very good, it is not always identical
to what you will see in your browser.

Maintaining Your Branding Throughout Your Site
Once you have decided on your site’s branding, you can keep the look and feel consistent by
retaining as many of the elements as possible in your external stylesheet. Once you are satis-
fied with the page display, create an empty stylesheet with a meaningful name using File ➤
New ➤ CSS to create a new empty stylesheet. Although site.css is a name that is descriptive
when you have more than one website, it will not tell you which site the site.css stylesheet
applies to. My preference is to name the stylesheet after the domain. That way if I am using
Windows Desktop Search or some other search to locate a file (particularly in backup folders),
I can tell at a glance the site to which it belongs.

Drag your new empty stylesheet to your chapter8.html page. Now you will see two CSS
sections in the Manage Styles task pane. Select all the styles in Current Page section, and drag
them to the external stylesheet section, as shown in the “before” and “after” of Figure 8-23.

Figure 8-23. Move styles from the page to your external stylesheet by dragging between the
sections.
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Although a stylesheet can go a long way to keeping your website branding consistent
from one page to another, it cannot keep the page structure consistent. <div> elements must
still be in the HTML.

Summary
In this chapter, you have used color and images to create a distinctive look and feel for your
website. You created a masthead to make an immediate visual connection between your pages
with a consistent navigation menu. Once you have created your site’s look and feel, move your
styles to an external stylesheet. This is one half of the equation in keeping the pages in your
website consistent. The other half is to use a template with locked regions where you want the
pages to be the same but still allow new content to be added to the content regions. In the fol-
lowing chapter, you will create a dynamic web template based on the page you just created.
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